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 End User License Agreement Cyrillic 3 Standard Version © AP Benson Ltd 2004 All rights in this product are reserved to A P Benson Limited (the 'Publisher').  This end user license agreement describes the rights and warranties granted to its customers by the Publisher. By using the enclosed CD-ROM you, the customer, are agreeing to be bound by the terms of this agreement, which includes the software license, software limited warranty, and hardware limited warranty.  If you do not accept these terms you may within 30 days of purchase return the CD-ROM containing the Software, unused and intact to the Publisher together with proof of purchase for a full refund. 1.  License: The Publisher grants the customer and the customer accepts a non-exclusive, and non-transferable license to use Cyrillic 3 Standard Version software (the 'Software') for so long as the customer complies with the terms of this Agreement.  2.  Copies: The Publisher grants the customer the right to make copies of the Software for back-up purposes only. The customer agrees to reproduce and incorporate this license agreement on any copies. It is expressly understood that such copies will not be used for any purpose except to substitute for the initial copy in the event that it is unusable.  3.  Use: In addition, the license granted herein includes the right to move the Software from one computer to another provided that the Software is used on only one computer at a time and that two people will not use the program at the same time on different computers.  4.  Security: The customer agrees to secure and protect each CD-ROM, the documentation, and copies thereof from copying (except as permitted above) or from modification and shall ensure that its employees or consultants do not copy or modify the Software or the documentation. 
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 5.  Ownership: The Publisher represents that it has the right to grant the licenses herein granted.  6.  Limited Warranty: The Publisher warrants the Software will perform substantially in accordance with its accompanying documentation and that the documentation correctly describes the operation of the Software in all material respects for a period of 30 days from the date of purchase of the CD-ROM. If the Publisher is notified of significant errors during this time it will correct any such demonstrable errors in the Software or the documentation within a reasonable time or (at its option) provide or authorize a refund of the price paid by the customer against return of the CD-ROM (containing the Software) and the documentation and written confirmation from the customer that all copies of the Software (whether made from the CD-ROM or by download from the Publisher’s web site) have been destroyed including any Software stored on the hard disk of any computer under the customer’s control. The above represents the customer’s sole remedies for any breach of the Publisher’s warranties.   Whilst all reasonable efforts have been made to test the Software and the documentation prior to first publication the customer acknowledges and accepts that the Publisher has not produced the Software or the documentation to meet the customer’s own specifications and that the Software could not be tested in every possible combination and operating environment and that it is not  possible to produce economically (if at all) computer programs known to be error free or which operate in an uninterrupted manner and that not all errors are necessarily capable of rectification.  7.  Liability: (a) The Publisher will not in any circumstances be liable to you or to any other person for any loss of profits or contracts or any other consequential or indirect loss or damage arising directly or indirectly (as a result of the negligence of A P Benson or otherwise howsoever) in connection with the supply of the CD-ROM (containing the Software) and the documentation or their use by you. 
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  (b) Except for any liability of the Publisher for injury to or the death of any person caused by negligence, which shall be without limit, the aggregate liability of the Publisher howsoever arising from or in connection with the supply of the CD-ROM (containing the Software) and the documentation (whether for breach of Agreement, negligence, misrepresentation or otherwise howsoever) will be limited to 125% of the aggregate invoice price of the CDROM (containing the Software) and the documentation in question.  8.  Law: This Agreement shall be governed by English law. 
 Should you have any questions concerning this license or this limited warranty or if you want to contact A P Benson for any reason, please write to:  AP Benson Limited E-mail: support@cyrillicsoftware.com Soane Point Tel: +44 (0) 8702 417019 6-8 Market Place Fax: +44 (0) 8702 417023 Reading RG1 2EG United Kingdom    Cyrillic 3 Standard Version is distributed with BrCaPro, a genetic risk analysis program, and MENDEL, a set of FORTRAN 77 routines. Both of these programs are the work of third parties and were not authored by and are not owned by A P Benson Limited (“APB”). APB distributes them “as is” and the customer uses them entirely at its own risk. If this is not acceptable to the customer, then the customer should not use the programs.  
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 BrCaPro Copyright 1997, 1998, 1999. Duke University. All rights reserved. BrCaPro is provided by Duke University without charge as a service to the research community. BrCaPro is provided "as is", without any warranties, express or implied, including any warranty of merchantability (or satisfactory quality) or fitness for a particular purpose, or that its use will not infringe upon any patent, copyright, trademark, or other rights. AP Benson, Duke University, and the developers expressly disclaim any and all liability arising out of the customer’s (or any other person’s) use of BrCaPro. No modification, copying, selling, sublicensing or other distribution of BrCaPro may be made other than as allowed under the license for Cyrillic 3 Standard Version. BrCaPro is developed by G Parmigiani, DA Berry and O Aguilar, authors of "Determining Carrier Probabilities for Breast Cancer Susceptibility Genes BRCA1 and BRCA2", Am. J. Hum. Genet., 62:145158,1998. Information for those who would like to obtain copies of BrCaPro separately from Cyrillic 3 Standard Version can be found at http://www.stat.duke.edu/~gp/brcapro.html.  MENDEL Cyrillic 3 Standard Version uses the Fortran 77 version of MENDEL developed by Ken Lange. The developer provides MENDEL free of charge and assumes no legal liability for use of his software or algorithms. MENDEL is provided "as is", without any warranties, express or implied, including any warranty of merchantability (or satisfactory quality) or fitness for a particular purpose, or that its use will not infringe upon any patent, copyright, trademark, or other rights. AP Benson and the developer expressly disclaim any and all liability arising out of the customer’s (or any other person’s) use of MENDEL 
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Copyright © A P Benson Limited 2004 All rights reserved. No part of this publication or the program Cyrillic may be reproduced, transmitted, transcribed, stored in a retrieval system, or translated into any language or computer language in any form or by any means, electronic, mechanical, magnetic, optical chemical, manual, biological, or otherwise, without prior written permission of the publisher. This manual refers to the standard version of Cyrillic 3. Disclaimer AP Benson Limited make no representations or warranties with respect to the contents hereof and specifically disclaims any implied warranties of merchantability or fitness for any particular purpose. Trademarks All trademarks and registered trademarks are the property of their respective companies. Author Cyrillic was originally written by Cyril Chapman. Richard Houlston is acknowledged for his assistance with risk calculations. In this new version Cyrillic has been rewritten under Dr Chapman's guidance by a team of expert programmers.  Publisher AP Benson Limited E-mail: support@cyrillicsoftware.com Soane Point Tel: +44 (0) 8702 417019 6-8 Market Place Fax: +44 (0) 8702 417023 Reading RG1 2EG United Kingdom    
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Support  E-mail support queries should be sent to   support@cyrillicsoftware.com  You may find an answer to your question on the CyrillicSoftware web site:  http://www.cyrillicsoftware.com/support/techsupport.htm   To log a support question by telephone, please call our UK office directly on:  +44 (0) 8702 417019  between the hours of 9.30 and 17.30 UK time Monday to Friday inclusive (excluding UK public holidays). Telephone calls will be logged in our support system and you will be contacted by e-mail, fax, or telephone with a solution or a request for more information.  Note on the Developer  For some years Senior Lecturer in Clinical Genetics at the University of Auckland School of Medicine, Dr Chapman moved to the Churchill Hospital, Oxford, in the summer of 1993, where he is now Clinical Director in the Department of Clinical Genetics. Cyrillic has its origins in a program developed by Dr Chapman from 1987 to 1989 for the Atari ST. The intention was to create a simple interactive method of entering pedigree data and family trees on the screen. The program has retained this original focus while it has evolved through several versions and operating environments. An early version of Cyrillic was described in a paper in the American Journal of Medical Genetics, 1990 36:155-160. The program's name was coined by the clinical geneticist Dr Mac Gardner who combined the name of the programmer with an interest he had in the Russian language.  
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Part 1:        
ABOUT           
THIS GUIDE    
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 About this Guide  The Cyrillic CDROM contains full documentation of the Cyrillic 3.0.400 software. This Getting Started Guide is intended to help you to get the software installed and to guide you through a first Cyrillic tutorial.  The full Cyrillic software documentation is contained in a .pdf file, which can be located using Windows Explorer or My Computer. The CDROM also contains the Adobe® Acrobat Reader software needed to read them. The most current version of the Acrobat Reader can be found on the Adobe® website at:  http://www.adobe.com/products/acrobat/main.html  Installing Adobe® Acrobat Reader  Skip the installation of Acrobat Reader is you already have software capable of reading .pdf files installed on your computer.  To install the Acrobat Reader software from the CDROM:  
• Insert the Cyrillic CD into your CD-ROM drive  The installation routine should run automatically. If it does not, you must locate and run autorun.exe:  
• Open Windows Explorer or My Computer 
• Navigate to D:\ (where D is the name of your CD drive) 
• Locate and double click autorun.exe to run the installation  The Cyrillic Software CD menu will open.  
• Select Install Adobe Acrobat 4 
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 Locating Cyrillic Software Documentation  When you have Acrobat Reader software installed, you will be able to read the Cyrillic 3 Manual:  The Cyrillic manual can be located on the installation CDROM in the following folder  
• D:\Manuals\Cy3manual.PDF  Where D: is the letter of your CD drive.   Please note that the manual is available after Cyrillic has been installed by default this is located at  
• Open Windows Explorer or My Computer 
• Navigate to C:\Program Files\Cherwell Scientific\Cyrillic 3\Cy3manual.PDF 
• Locate and double click on the .pdf file to access the full user manual  Alternatively you can use the Start Menu Start |Programs |Cyrillic 3 then select the Cyrillic 3 Manual  The manual contains sections reproduced in this Getting Started Guide, plus more detail on the tools and features such as risk analysis using BRCAPRO and MENDEL. functions. Note that the appearance of the shortcut menu depends on the area or component that  is clicked. See the Cyrillic Manual for a list of keyboard shortcuts.   
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Principal features  Cyrillic 3 is a program designed to display the most useful information about a pedigree for people working in human genetics, clinical genetics and genetic counselling. In addition all information relating to the pedigree is stored in a fully functioning database. Some of the principle features of this new version are:  
• Easy drawing tools  
• Integrated database which is updated as you draw  
• Enhanced printing options  
• Integrated risk calculations using BRCAPRO and MENDEL  
• Database support includes Microsoft Access and Borland Paradox  Individuals and families may be added to the drawing using toolbars and menus. Manipulation of the pedigree is simple using the mouse (click and drag) and individual properties (identification, age, genetic status) can all be added via dialogs or using the spreadsheet like table view. We have included two public domain genetic risk analysis programs, MENDEL and BRCAPRO. Cyrillic provides a convenient data input interface for these programs making risk analysis simple. You may use published data or data from your own research with these programs and the output may be saved to file or printed along with your pedigree.  The maximum size of a family is limited mainly by the processing power of your computer. 



Introduction 

Cyrillic 3.0.400  6

New in Cyrillic 3 Standard Version  In this version the underlying code has been completely rewritten. This version maintains Cyrillic’s user-friendly drawing interface but you will find it easier and more efficient to use than ever before.  
• All information stored in a database  
• New drawing interface  
• Table view constantly updated through link to the database and may be kept in view or removed  
• Completely user-defined view options for display in the pedigree or the table view  
• Access and Paradox database formats currently supported  
• New drawing tools to make pedigree drawing quick and easy.  
• Risk analysis using integrated tools (MENDEL and BRCAPRO).  
• Improved printing and print options  
• This version is intended primarily for genetic counselors and clinicians and does not include genetic marker function or haplotyping. These will be available in our next release.  
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 Hardware and Software requirements  Cyrillic 3 runs on the following Windows versions 98/95/NT4/2000/XP. The main program will take up to 20MB of hard disk space. Installation of the BDE, which supports the database functionality, will take an additional 15MB. The installation files are shipped on a CD-ROM disk and therefore your system will need a CD drive. Otherwise the standard Windows minimum hardware requirements must be met.  Installing Cyrillic  Place the CD into you CD-ROM drive and follow the on screen instructions. The installation routine should start on its own but if for any reason it does not:  
• Click the Start button on the windows task bar and select Run…   
• In the dialog box type D:\Setup.exe (assuming that D is the name of your CD drive) and Click OK  This is an independent installation and will not overwrite any older versions of Cyrillic. The installation includes a number of important files and applications. Some of these are as follows:  
• Cyrillic.exe. This is the main Cyrillic application. A shortcut will be added to your Start|Programs menu. You can also start the application by double clicking this file in Windows Explorer.  
• BDE  (Borland Database Engine). This controls all the database functions of Cyrillic 3 (see below for installation issues).  
• runMENDEL.dll. This contains the Fortran 77 code of the MENDEL risk analysis program. 
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• BRCAPRO4.exe. This is the program, which runs the BRCAPRO analysis.  
• Hdk3anim.dll and Hdk3ctnt.dll (in the Windows System folder). These are supporting files for the Cyrillic Help system.  
• Example.mdb. This sample database contains some of the pedigrees described in this guide.  If your computer is a shared workstation or uses a shared copy of the Borland Database Engine, please ask your network administrator to read the following section before you attempt to install Cyrillic 3.  If you are a current BDE user (ask your Network Administrator) and you are trying to install the software on a PC where the Borland Database Engine already exists, it is possible that the installation will fail. If the BDE files are read-only, or the current user has read-only access to the BDE directory (network or local) then installation will fail.  This can be resolved by   
• Logging on with write-access (e.g., as Administrator -- also required if ODBC is installed). 
• Making the files NOT read-only,  or (in the case of a network installation only)  
• Remove the following two keys from the registry: "HKEY_LOCAL_MACHINE\Software\Borland\BLW32" "HKEY_LOCAL_MACHINE\Software\Borland\Database Engine" This will allow the BDE to install locally.  IMPORTANT: This last option involves editing the registry. Before you edit the registry, make sure you understand how to restore it if a problem occurs. For information on how to do this, see the   
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 "Restoring the Registry" Help topic in Regedit.exe or the "Restoring a Registry Key" Help topic in Regedt32.exe.  If you are in any doubt the consult your systems/network administrator or contact the Cyrillic support team.  Licensing Cyrillic Cyrillic software security  Cyrillic 3 Standard Version is designed as a desktop or single user software application. Cyrillic’s security locks the application to the machine on which it is installed. Therefore you will not be able to install Cyrillic 3 on a network drive and run it from a remote computer. This also means that you must follow certain procedures in order to transfer the software to a different computer - the License agreement does not allow you to run Cyrillic on two different machines at the same time.  Demo license button  If you have not yet purchased Cyrillic you can use a fully functioning version of the software for a 30-day trial period.  Each time you start Cyrillic the license dialog box appears. Simply click the “Demo License” button to use all the features of Cyrillic for the remainder of your 30-day trial period. When this period has expired this will gray out and you must purchase the software if you wish to continue to use it.  
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Full License button  When you purchase Cyrillic you need to activate the license before you can start to use the software (unless you are taking advantage of the 30-day trial period – see previous section). To do this you need to register the software with A P Benson Ltd. When you register with us you will be given a code that will activate your full license.  In order to activate your full license, please carefully follow the instructions outlined below.  When you start Cyrillic the license dialog box appears:  
• Click the Full License button  
• Make a note of the two numbers labelled: User Code 1 and User Code 2  
• Click the Freeze button  This last step saves the two User Codes providing us with a unique identifier to enable us to create your license activation code. It also closes the application.  
• Now contact A P Benson by phone, email, fax or via our website, to request your license activation code.   The activation code web form can be found at  http://www.cyril licsoftware.com/support/activate/activator.htm  (see support section for other contact details)  Please provide the following items of information:  
• For Contact details – name, address, telephone number, email address.  
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• The software serial number (this is the same as the invoice number we will have sent to you after your purchase).  
• The two user codes, User Code 1 and User Code 2, that you made a note of prior to clicking the Freeze button.  Once you have received your activation code from us start your Cyrillic software and the license dialog box will appear.  
• Click the Full License button  
• Type the activation code into the Activation Code box and click OK.  Your software is now fully licensed.  Installing Cyrillic on another machine  This is used when you wish to install Cyrillic on a new machine - see button below for the full description of how to transfer your user license to a different computer. Transferring the License  Once you have registered Cyrillic 3 a single user license will not allow you to install and run the software on another computer.   If you wish to permanently install Cyrillic 3 on more than one computer we will issue you with a second activation code at the discounted license price equivalent to an upgrade from Cyrillic 2 to Cyrillic 3 (please visit our website for current pricing details).  Under the single user license you are allowed, however to transfer your license to a new machine. Doing this deactivates the license on the old machine. Following the procedure below allows you, for example, to install Cyrillic at home as well as in the office but you must transfer the license each time. You will not be able to install on two machines and run the software on both at the same time.  
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  To prepare a license transfer you will need a floppy disk.  The following description assumes you wish to run Cyrillic at home as well as in the office - but obviously applies to any transfer such as reinstalling Cyrillic if you should upgrade to a new computer.  The license transfer works by generating a request for a license transfer whilst at home. When you take this request to the office on a floppy disk the office computer recognizes the request and checks out the license to the floppy. When you return home check in the license. From then on you can easily transfer the license between the machines, checking out from one before checking in to the other. Always remember to save your work before starting the transfer process.  
• Install Cyrillic on your computer in the office  
• Request an activation code from A P Benson Ltd  
• Activate Cyrillic  
• Install Cyrillic on your computer at home  
• When prompted choose to Continue unlicensed  
• When you have finished your session save your work  
• Place a floppy disk in the disk drive  
• Select the Help|License Transfer menu item  
• Click the Request license radio button and click OK to start the license request  
• Click OK to close the confirm dialog   
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 Note that if you are outside the 30 day trial period you will be returned to the opening 'unlicensed' dialog  When you return to the office your version of Cyrillic is still licensed and so it will start and function properly. When the time comes to go home you will need to check out the license to the license transfer to the floppy, now called the Transfer disk. So, when you have finished saved your work:  
• Place the Transfer disk in the floppy drive  
• Select Help|License Transfer  
• Click OK to check out the license  A dialog will confirm that the Cyrillic license has been transferred. When you click OK the application will close. Now take the Transfer disk home and start Cyrillic again. Remember that this version is still unlicensed and so you will be prompted to either continue unlicensed or to Activate the license:  
• Click Continue unlicensed  
• Place the Transfer disk in the floppy disk drive  
• Select Help|License Transfer  
• Click the Check in license radio button  
• Click OK  A dialog will confirm that the license transfer is complete and you will be able to continue working. When you have finished you will need to check out the license in order to transfer it back to the office.  
• Save your work 
• Select Help|License Transfer 
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• Click OK to check out the license  A dialog will confirm that the version of Cyrillic is now unlicensed and will terminate the application.  When you start Cyrillic in the office you will be greeted by the License dialog.  
• Insert the Transfer disk  
• Choose Transfer License  
• Select Check in license in the next dialog and click OK    Now each time you change machines you will now simply check out the license from the machine you are currently working on and check in on the other machine. Using Cyrillic on a network  The current user license allows you to install Cyrillic on a single computer. The software security locks the application to a particular machine and you will therefore not be able to install on a network and run it from a remote machine. You may, however, be able to share databases on a network drive. If you do this then you should consider the following:  
• You should have read write permissions for the network drive or drives 
• More than one person will be not be able to access and work on a single database at the same time 
• If you are using risk analysis tools, manifestations and disorders then these are a property of the database and the database will be locked  In all cases you should first check with your systems/network administrator before calling the Cyrillic support team. 
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Conventions used in Cyrillic documentation 
 

• Program menu commands are referred to as File|Open, for example, meaning select Open from the File menu. 
• Angled brackets are used to refer to keyboard characters. For example, <Esc> means press the Escape key, <Ctrl+C> means hold down the Control key whilst pressing C, <Alt, F,O> means press the Alt key followed by F then O. 
• LMB refers to the Left Mouse Button and RMB refers to the Right Mouse Button menu. For example, RMB|Parameters means click the right mouse button within the Model Viewer panel and select Parameters from the menu.  Cyrillic has been developed to allow you to work in a manner you find most convenient - either with the mouse, keyboard or a combination of the two. There are usually two or three ways to do most things. Below is a list of conventions and terms used in the rest of the help file.  Mouse functions  In this help file we use the following terms to describe mouse functions.  
• Point: move the mouse until the cursor is over an object.  
• Click: Press the main mouse button (usually the left button) once.  
• Select: Clicking on an object highlights the object showing that it has been selected. e.g., selecting an individual creates a red square around the individual, clicking on a marriage line highlights the line. Once an object is selected certain Cyrillic functions become active. In menus and toolbars you will notice that more items become active (inactive items are grayed out). Several objects may be selected by clicking on them in sequence whilst holding the  
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• control (Ctrl) or Shift key down. If you have the Table (grid) View open the individual row is also highlighted making it easy for you to find the properties and data relating to that individual.  
• Double-click: Press the mouse button twice in quick succession. Double clicking usually performs some function such as opening a dialog box pertaining to the object on which you have double clicked, e.g. double clicking an individual opens the Individual Properties dialog box, double clicking a marriage line opens the Marriage Properties dialog box.  
• Drag: Objects can be moved around the Windows desktop by dragging them. This means clicking on the object and holding the mouse button down whilst moving the mouse. Multiple individuals may be selected by clicking on an empty part of the drawing and dragging the mouse around the group you wish to select.  
• RMB, The Right Mouse Button: This is conventionally the secondary mouse button. If you are left-handed you may have to reset the mouse buttons (using the Mouse Properties dialog from the Windows Control panel) but in this manual we always refer to the secondary button as the right mouse button or RMB. Clicking with the RMB on an object invokes a context menu. This is a menu of functions relating directly to the object that has been clicked. You may see additional functions but unless they are available for that object then they will be grayed out and cannot be selected. 
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Keyboard functions  The keyboard may be used for just about every function within Cyrillic 3. This includes data or text input, opening menus and dialog boxes. Keyboard alternatives to mouse functions are often called keyboard shortcuts. The notation used for these refers to the common name or label of the key, Shift, Ctrl, Alt and F1, Q,W,E and so on.  Shortcuts often involve pressing more than one key at a time. Instructions such as Alt+F3 mean press the Alt key and whilst holding it down press the F3. It is not necessary to press them both at exactly the same moment. Menus   The main menu bar is at the top of the Cyrillic window. All functions can be invoked using these menus. To open view a menu:  
• Click on the menu with the mouse  or  
• Press the Alt key and the letter that is underlined in the menu text. e.g. for the File menu click Alt+F  Not all menu items are available all of the time. Those that are unavailable will be grayed out and cannot be selected. Many menus have sub-menus e.g. the Modify Individuals menu:          
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  The Modify Individuals menu with Gender               sub menu selected  In the manual and help file the instruction to select the item Change to male will appear as:  

• Select Modify Individuals|Gender|Change to male menu item  There are two ways to do this. With the mouse and with the keyboard.  1. With the mouse:  
• Click on the menu text, Modify Individuals, in the menu bar  
• Point to the Gender item  
• Point to the Change to male item in the sub menu  
• Click to select this item  
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 Note that items are highlighted as your cursor moves over them. Items with sub-menus are easy to see because they have an arrow pointing to the right.  2. With the keyboard:  
• Press Alt+M to open the main menu  
• Use the down arrow key to move through the items  
• When you reach the gender item press the Right arrow to open the sub-menu  Use the down arrow again to highlight the item of choice In this case it is the first item and is automatically highlighted.  
• Click Enter to select  The change is invoked and the menu closed. Dialogs  Dialogs or Dialog boxes are secondary windows, which allow the user to add or change data and program settings. There is no special notation used for dialogs though the following section shows how the different elements may be used to make selections or additions to your pedigree.  
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Using dialog boxes  A dialog typically comprises some or all of the elements described below. A typical example is the Individual properties dialog.   Navigating dialogs  To select a property prior to editing:  · Click on the item with your mouse  or  
• Use the Tab key on your keyboard to cycle through all the available components  When a dialog component is selected this will be indicated:  
• Edit boxes show a flashing cursor  
• Drop down lists and edit boxes with default values highlight the text  Check boxes display a dotted line around the label text  Buttons   Usually placed at the bottom right or top right of the box. Labels include an underlined letter e.g., OK. pressing Alt+ the underlined letter has the same effect as clicking on the button with your mouse. The three most common buttons are:  
• OK: Accepts any changes and closes the dialog.  Pressing the Return key may also result in the dialog accepting changes and closing. Exceptions are when you are editing text or  
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 number boxes where you are permitted to add carriage returns e.g., when adding text to the Annotation dialog (see Chapter 9. of the Cyrillic Manual -Annotating the pedigree.).  
• Cancel: Closes the dialog without making any changes 
• Help: Opens the help file at a page detailing the dialog box and/or its related functions  Drop down lists  If there are a number of items from which one is to be selected a drop down list is used. The default item is displayed in the box and clicking the down arrow at the right hand side opens the list.    The proband drop down list from the Individual properties dialog   The scroll bar is used to show items which are initially out of view. As with menus items are highlighted when the mouse cursor is placed over them. To select an item from a drop down list:  
• Click the down arrow at the right hand side 
• Locate the item you wish to select either by dragging the scroll bar up and down or clicking on the up and down arrows 
• Click the item   



Introduction 

Cyrillic 3.0.400  22

 You can also select items using the keyboard. The list is selected when the default item is highlighted.  
• Press the Down or Right arrow key to move through the list  In this case the list does not actually open but items are displayed in turn in the box.  If you reach the end of the list you can move back up by pressing the Up or left arrow key until you locate the item you wish to select. Edit boxes  An edit box is a box where the user can enter text of their own. There may be restrictions on the length of text but warning will be given if you make a mistake in this respect. Some edit boxes only accept numerical text. In this case a default number is included when the dialog is opened and they usually have up and down arrows on the right hand side. Clicking on an arrow with the mouse increases (up) or decreases (down) the value. Some text edit boxes are multi line and can accept carriage returns without closing the dialog.  Check boxes a check box is used when there are only two possible settings for the property - on or off. These appear as a small square - much smaller than an edit box or drop down list. To change the setting:  
• Click on the box or the text or  
• Press the Space bar  The item is set to On when a tick is shown in the check box. If you are using the keyboard to navigate through the dialog the item is available to be changed when a dotted line appears around the label text. 
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Radio buttons   Radio buttons are similar to check boxes and are used to choose between a number of exclusive options.    The 'affection pattern' radio buttons in the Define Manifestations dialog  Radio buttons generally appear as circles and when selected have a black dot placed in the circle. In this example you can choose 1 or 2 affections, but not both. To select one affection:  
• Click on the button - the circle adjacent to the text or on the text '1 affection'  or  
• Press Alt + 1 (note that the '1' is underlined) Navigating dialogs Navigating Dialogs  To select a property prior to editing:  
• Click on the item with your mouse or 
• Use the Tab key on your keyboard to cycle through all the available components including the buttons  When a dialog component is selected this will be indicated:  
• Edit boxes show a flashing cursor 
• Drop down lists and edit boxes with default values highlight the text  Check boxes display a dotted line around the label text.   
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A Cyrillic guided tour  This guided tour is intended to give an overview of the principle features of Cyrillic 3 Standard Version. The following chapters show how to perform individual tasks but for a start it will be useful to become familiar with the Cyrillic interface.  Step 1: Start Cyrillic  The installation routine for Cyrillic automatically adds a Program item to the Start|Programs menu on your Windows desktop. To start Cyrillic:  
• ·Select the Start|Programs|Cyrillic 3| Cyrillic item from the Windows task bar  If this is the first time you have started Cyrillic the Recent pedigrees dialog will be empty and so click Cancel to close it. Initially the program interface is fairly empty so you need to open a database. We have included a sample database, example.MDB with the installation. This includes the pedigrees used in this tour and those used in some of the later tutorials. To open a database:   
• Click the Connect database icon or select the File|Connect database menu item – you must always open a database before you can draw a pedigree – all Cyrillic pedigrees are stored in database files.  
• In the dialog that appears click Connect MS Access and from the open database dialog select tutorial.MDB and click Open  
• The Database properties dialog opens automatically and so click OK to close it  Note that you do not need to have Microsoft Access on your system. Cyrillic merely stores the data in this format. If you do, however, have   
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 Microsoft Access you will be able to open and look at the database using the database application.  Step 2:  You now need to open a pedigree.  
• Click the Open Pedigree icon or select the File|Open pedigree menu item  
• In the Open pedigree dialog select Guided Tour and click Open  The Cyrillic interface should now look something like the figure around below.  

  The Cyrillic Window  The window is divided into five main regions. In the centre is the drawing area, conveniently marked out by dotted lines into pages. At the very top is the menu bar. To open a menu just click the menu name with the mouse or press the Alt button on your keyboard and   
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 at the same time press the letter that is underlined in the name. Below the menu bar are the toolbars. The icons on the toolbars allow   you to control almost every aspect of Cyrillic using your mouse. Underneath the drawing area is the Table view. This is constantly updated with information added to the pedigree. Alternatively you can add information directly to this spreadsheet like view of the pedigree. For example  
• Click on the individual named Peter and note that the column with First name 'Peter' in the table is also highlighted  
• Click on the cell containing the First name and press Enter  
• Type the new name Robert and press Enter  At the very bottom of the Cyrillic window is the status bar. This lists relevant information about the pedigree; the path and name of the database, the name of the current pedigree and basic information e.g. the number of individuals and number of marriages. Step 3: Add some individuals  Drawing with this version of Cyrillic is very easy indeed. You can use new menus or toolbars to add new individuals and relationships. Now we will add a family to the middle son (second generation) of the Guided tour pedigree.   
• Click the middle son (named Andrew)  
• Click the New partner (female) icon   
• Click New son     
• Click New daughter    When a new spouse is added the marriage line is highlighted ready for the addition of a family of children. Note also that as the family is  
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 added the pedigree automatically expands to make space. Occasionally you may find that siblings overlap or new families are closer than you would like. If this happens just click the Redraw button.  If you prefer you can use menus to build your pedigree. All individuals are added through the Add individuals menu. This also appears in the right mouse button or context menu. Step 4: Edit Properties  We have already seen that you can easily edit properties using the properties Table view. Another method is to use the Individual properties dialog opened by simply double clicking a symbol.  The dialog details all of the default properties you may edit. For example to edit the properties for Andrew's new spouse.  
• Double click the symbol for the new spouse you have just added  
• Ensure that the Individual properties tab is selected  
• In the First name edit box of the dialog type the name Anne  
• In the Age edit box type the number 40  
• From the Genetic status drop down list select Carrier  
• Click OK to accept the changes and close the edit box  You can also change the properties of a marriage. To open the marriage dialog double click the relationship line between two individuals. To edit the marriage properties of Andrew and Anne:  
• Double click the line joining the Symbols Andrew and Anne  When a line joining two individuals is selected you will notice that not only is this line highlighted but also the lines to all children of  
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 that relationship. This is particularly useful if you have complex relationships where sibships overlap.  The dialog details the properties of both individuals and you can add a relationship ID and any comments. You can also add the type of relationship:  
• From the marriage type drop down list select Divorced 
• Click OK and see that the divorced symbol is added to the marriage line  Step 5: Select and Move Individuals  To select an individual just click on the individual symbol. You can also move individuals around the pedigree using the Up/Down/Right and Left individuals arrow keys on your keyboard. Note that the selected individual is also highlighted in the Table view. To move an individual:  
• Select the individual  
• Drag the highlighted symbol, with your mouse to the new location To select and move a group of individuals:  
• Dragging your mouse cursor around the group of individuals whilst holding down the left mouse button or  
• Click on the first individual  
• While pressing the Shift key, click on the additional individuals  
• Click and drag the group to the new location  
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Step 6: Take a Snapshot  Although you can undo single moves in Cyrillic a more useful feature is to take a snapshot. This saves the pedigree and all the related information at any one time. So as a safety net when making changes to pedigrees:  
• Select New snapshot from the Edit menu  
• In the Create new snapshot dialog type a name for snapshot and click OK (the default name is Snapshot 1)  
• Change the pedigree - move individuals, add data etc  
• Having decided the changes were unsuitable select Go to snapshot from the edit menu and select Snapshot 1 from the sub menu  
• In the Create new autosnapshot dialog click No  Your pedigree reverts to its previous state. This is valuable because you can create as many snapshots as you like and it saves all relevant data whilst the pedigree is open. Step 7: Change the View  The Cyrillic window is completely configurable by the user. Perhaps the view you prefer more drawing space than is initially given. To increase the space:  
• Remove the table view by placing the cursor over the line adjoining the Table view and the main drawing window (the split cursor appears when it is positioned correctly)  
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• Drag the Table view down until it disappears from sight. To view it again simply drag it up again 
• Remove one or all of the toolbars by selecting toolbars from the View menu 
• Uncheck and toolbars you wish to remove           The Toolbars sub menu    You can also rearrange toolbars on the screen by clicking on the bar at the left hand side and dragging them (within the toolbar space) to the desired location.  Almost everything else can be changed using the View option dialog.  
• Select Options from the View menu or press F6   To change the colour used to emphasize selections:  
• Click the button labelled Selection  
• Choose a new colour from the Colour dialog and click OK  
• Click OK to close the View options dialog  
• Select an individual to verify the change  Now explore the view options dialog. You can change all colours used, the size of symbols, how they are spaced on the drawing, whether Cyrillic will detect and display consanguinity and the colour 
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and shape.of the proband arrow. To see the changes that can be made to the Table view click the Table options tab in this dialog.  Step 8: Change Information Displayed  One of the most common tasks is to change the information displayed.  In Cyrillic this is completely under your control, information on the pedigree can even display different information in the Table and on the drawing.  
• Open the View options dialog (View|Options menu or press F6)  
• Click Drawing fields  This opens the Displayed fields dialog.   

  The displayed fields dialog  The left hand panel lists all the data fields that may be displayed. These include default data fields, fields you have defined yourself and any imported from other pedigree drawing programs. 
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 The right hand panel lists those currently being displayed. To add a field from the left:  
• Select the field in the list by clicking on it  
• Click the button labelled >   To add all the fields:  
• Click the button labelled >>  To remove all the fields:  
• Click <<  
• Click OK to accept the changes and then click OK in the main Options dialog.  To set the fields to display in the Table simply click the Table fields button in the View options dialog. This opens an identical Displayed fields dialog - but changes operate only on the Table view. Step 9: Add an annotation  To add a text annotation to your pedigree:   
• Click the Annotation toolbar icon or press Ctrl+T  
• Type some text in the Annotation dialog  
• Click OK to place the text on the pedigree  The annotation dialog allows you to save the annotation as a simple text file (Save as text… button) and to load simple text files from disk. A Font button opens the dialog allowing you complete control over the look of the text. Once the annotation is placed on the pedigree you can place it anywhere by clicking and dragging. To edit an annotation double click the text to reopen the annotation dialog. 
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Step 10: Print the pedigree   Printing is controlled though the Print preview window.   
• Ensure that no individuals are selected (click on an empty part of the drawing area)  
• Click the Print preview icon, select Print from the File menu or press Ctrl+P  
• In the Print preview window click the Fit to page icon  
• ·Click the Print icon  The print preview window provides a complete preview of the pedigree before printing. To control the output options open the Page setup dialog.   The toolbar makes it easy for you to fit the pedigree to a single page, scan through a large pedigree covering several pages or create a circular pedigree to fit it on one page. Explore the toolbar buttons and print your pedigree before closing the window and returning to the Cyrillic main window.  Other functions In addition to creating pedigrees and saving all relevant data in the in Cyrillic Cyrillic database you can also:  
• Add to and customize the database by creating your own data fields 
• Search the database 
• Highlight or hide sections of the pedigree 
• Import pedigrees from older versions of Cyrillic (2.x) and in CSV and GEDCOM format 
• Export CSV and GEDCOM formatted pedigrees 
• Run genetic risk calculations through Cyrillic using MENDEL and BRCAPRO   
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Starting and exiting Cyrillic  As with other Windows programs there are several ways to start and close Cyrillic. Starting Cyrillic From the Start Menu  Installing Cyrillic automatically creates a Cyrillic program item.   
• Select Cyrillic from the Windows task bar start menu, i.e., Start|Programs|Cyrillic 3|Cyrillic Starting Cyrillic From Windows Explorer  Open Windows Explorer using one of the following methods:   
• Double-click the My computer Icon on the desktop  
• Select Start|Programs|Windows Explorer from the task bar Start menu  
• Press the Windows key + E  
• Locate the Cyrillic3.exe file  The default installation is C:\Program Files\Cherwell Scientific\Cyrillic3\Cyrillic3.exe.  To start Cyrillic:  
• Double click the file Cyrillic3.exe Starting Cyrillic From a shortcut   You can create a short cut on your Windows desktop using the following methods.  
• Right mouse click on the Cyrillic 3.exe file in Windows Explorer 
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• Select Create shortcut from the context menu  
• Drag the shortcut to the desktop   or   
• Simply drag the icon for the Cyrillic3.exe file onto the desktop   Change the text labelling on the shortcut icon by:   
• Click once on the icon to select but not start the program  
• Click on the text label  
• Edit the text to something you recognize such as “Cyrillic 3”  
• To start Cyrillic from this shortcut double click the icon on the desktop Using the Windows Start Menu  You can add a shortcut to the main start menu rather than using the Windows Start program group on the start menu.  
• Locate the Cyrillic3.exe file in Windows explorer 
• Drag the Cyrillic.exe icon onto the Start button on the Windows task bar 
• To start the program select Start|Cyrillic 3 
• Select Start|Run from the task bar start menu 
• When the Run dialog opens type Cyrillic3 in the edit box 
• Click OK or press the Return key The recent pedigrees dialog  On starting Cyrillic you will be greeted by the Recent pedigrees dialog. This lists all of the pedigrees you have been working on. To open the pedigree select it and click Open. This automatically opens a database and the pedigree – and is a very quick way of working. 
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 You can view the Recent pedigrees dialog any time by selecting Reopen pedigree from the File menu. Closing Cyrillic  When you have finished working with Cyrillic 3 you can close the program in the following ways:  
• Select File|Exit or  
• Click the Close button (labelled x) in the upper right hand corner of the Cyrillic window.  or  
• Press Alt+F4  In all cases you will be prompted to save any changes to pedigrees you have been working on.    
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Create a Microsoft Access database  The Connect to database dialog Working with databases  A key feature of Cyrillic 3 is that all Cyrillic data, including details of the pedigree drawing are stored in a database. Each time you use Cyrillic you will need to open a database to work in.   More information on databases in general is given in Chapter 14 of the user manual. Introduction to databases.   In this chapter we cover some practical aspects of using the Cyrillic database; creating, saving, opening and closing databases. Create a Cyrillic database  Although this may sound complex it is no more difficult in practice than creating any other file or document. The difference is behind the scenes. You select menu items and use dialog boxes but Cyrillic creates the infrastructure of the database that is more complex than a simple document or file.  Start Cyrillic as shown in the Chapter 3. Then either:  
• Select the File|Connect database menu item   or  
• Click the Connect database icon on the Database Toolbar This opens the Connect to database dialog.        
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   The Connect to database dialog.  This comprises four main buttons. To create a new database in Microsoft Access format:  
• Click Create MS Access  This opens the New database dialog. As indicated in the Connect… dialog you can also create a database in Paradox format.  

  The New database dialog  This 'new file' type of dialog opens in the default location (the main Cyrillic 3 folder). If you wish to store your database elsewhere then use the Save in: drop down list. Once you have located the folder   
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 where you will store the database and the Up one level button to navigate to the required location on your hard drive or network:  
• Type a suitable name for the database in the File name edit box, e.g., tutorial 
• Click Save  It may take a few seconds for the database to be created. After a short time the Database properties dialog opens. This details the name and location of the database and allows you to add useful notes for future reference.  

 The database properties dialog  Setting the When creating a database the Database properties dialog opens. This database details the name and location of the database and allows you to add properties useful notes.  
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• Type your name or initials in the Author edit box 
• Add any notes to the Comments edit box 
• Click OK   The Properties dialog displays the date the database was created and when it was last edited - these cannot be changed by the user. If you wish to view or edit the database properties at any time:  
• Choose the File|Database properties menu item  The procedure is similar to creating an Access database but a slightly different dialog is used. Paradox databases consist of a number of files held in a single folder. When creating a database you therefore need to create a folder.  
• In the Connect database dialog click Create Paradox   

 The Select directory dialog used for creating Paradox databases     
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 If you have already created a folder for your Paradox database, using Windows Explorer for example, use the navigation tools for locating the folder. If you wish to create a new folder:  
• Type the name of the folder in the Directory name edit box  
• Click OK  You will then be prompted to confirm that Cyrillic should create the folder. Accepting this leads you to the database properties dialog as for the Access database. Other common database functions Saving the database  Once created the database is automatically saved - note that there is no option to 'Save database' on the File menu. The only thing you have to save is the pedigree. Close the database  You may wish to work on pedigrees in different databases but you are only allowed to have one database open at a time. To close a database:  
• Select File |Disconnect database or  
• Click the Disconnect database icon on the Application Toolbar  You will be prompted to save your work (changes to pedigrees) before the database closes.  
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Open an existing Cyrillic database  To open an existing database either:   
• Select the File|Connect database menu option  or  
• Click the Connect database icon on the Database Toolbar   This opens the Connect to database dialog box  
• Click Connect MS Access or Connect Paradox   Now:  
• Navigate to the database location using the Look in drop down list or the Up one level button  
• Click on the database with which you wish to work  
• Click Open  This opens the Database Properties dialog.  
• Make any additional notes  
• Click OK to close the dialog  When opening a Paradox database the dialog requires that you locate the folder in the directory tree. Once located click to select and click OK. Although you have opened the database no pedigrees are yet opened and so the main Cyrillic window is blank. In the next chapter we will open the pedigree and add individuals.  
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 Creating and opening pedigrees  Before starting to draw you must have a database and a pedigree open.  To create a new pedigree:  
• Select File |New pedigree  or  
• Click the New pedigree icon  This opens the Pedigree properties dialog.  
• Add a name for the pedigree and any notes 
• Click OK To open a pedigree:  
• Select the File | Open pedigree menu option or  
• Click the Open pedigree icon   This opens the Select Pedigree dialog.  
• Locate and click on the pedigree you wish to open  
• Click OK  
• Make any changes to the details in the Pedigree Properties dialog and click OK      
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 The select pedigree dialog   A tab with the pedigree name appears at the top of the drawing area. You may have several pedigrees open at one time and switch between them by clicking on the tabs Searching for pedigrees  The Search button on the Open pedigree dialog allows for simple searches to be performed on the current database. This is particularly useful if you have large databases with many pedigrees. To search for pedigrees containing specific information:  

• Select File|Open pedigree or click the Open pedigree icon 
• Click Search or Alt+S This opens the search dialog        
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  The Search pedigrees dialog  This comprises two drop down lists. The upper lists searchable fields of the database, the lower one is initially empty and is in effect an edit box. The fields on which you can search are:  INDIVIDUAL:  First name INDIVIDUAL:  Last name INDIVIDUAL:  Maiden name INDIVIDUAL:  Known as PEDIGREE:  Identification PEDIGREE:  Name PEDIGREE:  Author  Accordingly it is possible to find pedigrees either by their contents or by the person who created them.  Under the heading ‘Matches’ type the text you wish to search for. For example if you want to find pedigrees with the last name or surname Jones:  
• From the drop down list select INDIVIDUAL: Last name  
• In the edit box below TYPE Jones  
• Click OK  
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 If the search is successful the Open dialog appears with the pedigrees that include the surname Jones listed.  When you search again, you will find text from previous searches saved as a drop down list. Either type new text for the search or select a word from the list. Search with wildcards  A wildcard is a character used to represent any other characters in a search. For example if you have coded all of your pedigrees with a surname and, say an area or zip code you might want to search only on the name and collect all the areas. For example if your style of naming is say JonesLSNW1 to represent all the pedigrees with the surname Jones in an area coded as LSNW1 and you wanted to search for all pedigrees named Jones and in any area then you could type Jones* in the Contains field of the Search dialog. ‘*’ is the wildcard and represents any string of characters. So searching for Jones would find all of the following pedigrees; Jones1, JonesLSNW1, JonesLSNW2, Jonestown and so on.  The wildcard can also be used in the middle of a string. E.g. Pe*er would find Peter, Perimeter, Pe8er and so on. Wilcards are useful but should be used with caution. Sometimes you may get too many hits or returns on your search making it a fruitless exercise. Furthermore the rules on searching are slightly different for Access and Paradox databases. Searching in Microsoft Access Databases  Searches in Microsoft Access databases are case insensitive. Thus searching for jones will find all of Jones, jones, JoNes and JONES.   Two wildcards are available: 
• asterisk, *, represents any string of characters as shown above 
• The question mark, ?, represents any single character i.e., Pe?er will find Peter, Peler, Peper, Pe7er but not “perimeter” as would Pe*er. 
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Searching Paradox Databases  Searches in Paradox databases are case sensitive. Thus Peter would find only Peter and not peteR or PeTer.   There is only one wildcard, the percent sign, %. This represents any string of characters as described above for * in Access databases. Delete pedigrees   To delete a pedigree:  
• Close all pedigrees in the database  
• Choose Delete pedigree from the File menu   
• Select the pedigree you wish to delete from the Select pedigree dialog 
• Click OK  You will be warned that deleting a pedigree cannot be undone.  
• Click OK to confirm the deletion Draw a pedigree using the toolbar  In this section we will draw the following three-generation pedigree.  
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 A sample pedigree to draw    

• Click the New male icon   
•  Click the New partner (female) icon.  
• Click the New son icon   
• Click the New son icon again  
• Click the New daughter icon  
• Click on the symbol for this daughter.  
• Click on the new add-partner (male) icon  
• Click on the new daughter icon  
• Click on the symbol for this daughter  
• Click New younger monozygous sister   
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Draw using the main menu  To create the same pedigree drawing using the main menu:   
• Select Add individuals|New male 
• Select Add individuals|New partner (female) 
• Select Add individuals|New son 
• Select Add individuals|New son 
• Select Add individuals|New daughter 
• Click on the daughter symbol 
• Select Add individuals|New partner (male) 
• Select Add individuals|New daughter 
• Select the daughter just added 
• Select Add individuals|New younger monozygous sister Draw using the context menu  Clicking anywhere on an empty pedigree drawing with the right mouse button opens the context menu. If no individuals are selected or the pedigree is empty then only the Add new mal/female/individual sub menus are active. When an individual is selected then all the menu items are active. The sub menu, Add individuals, is identical to the main Add individuals menu. You can therefore draw this pedigree using the RMB menu following the instructions above. When using the RMB menu note:  
• If no individuals are selected then only New individuals are available 
• You do not have to click on an individual symbol to invoke the RMB but the options available are in context with whatever is selected 
• If a marriage line is selected then you can only add offspring or new individuals 
• If an individual is selected you can add new relationships and offspring 
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Adding whole groups  The Add individuals|Add family of siblings and Add families |Add family of siblings menu items allow you to add groups of individuals to an individual in the pedigree.  
• Select an individual  
• Choose the Add individuals|Add family of children or press F8    The Add family of children dialog uses either of two methods to define the family.  
• Use the number edit boxes at the top to select the number of sons, daughters and children with undefined gender  or  
• Use the set of radio buttons to define the sibship  
• Starting with the first active set of buttons select male, female or unknown  
• Having selected the first then the second sibling becomes active so choose the gender of the second sibling  
• Continue until you have the desired sibship           
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 The Add family of children dialog  This method has the advantage that it is easier to define the whole sibship in terms of their relative ages and uses the convention that the first sibling is the elder and that consecutive siblings are younger. You can achieve the same effect using the number edit boxes and the arrows to scroll the age one year at a time. For example to add a son, daughter and a younger son:  

• Click the up arrow next to the Son(s) edit box to add 1 son  
• Click the up arrow next to the daughter(s) edit box to add 1 daughter  
• Click the up arrow next to the Son(s) edit box so that it reads to add 2 sons  To do the same using radio buttons  
• Click Male  
• Click the next column, Female  
• Click the next column male  
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Saving the Pedigree  After drawing a pedigree you will need to save it. Either:  
• Select File |Save pedigree·  
• Click the save pedigree icon   or  
• Press F4 
• If you have several pedigrees open then you can save all of your work by clicking the Save all tool or selecting           File |Save all  Whenever you close Cyrillic you will be invited to save any work you have done:  
• Click Yes to save the changes you have made to the pedigrees in the database and close the program    
• Click No to close the program without saving  
• Click Cancel to close the dialog and return to Cyrillic - without saving Delete individuals   To delete an individual or group of individuals:  
• Select the individual or group of individuals  
• Press the delete button  Note that deleting an individual cannot be undone unless you take a snapshot (Edit|New snapshot menu) before the deletion and then return to the snapshot later (Edit|Go to snapshot menu). 
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Arranging the pedigree on the page  The main drawing area on the Cyrillic window is marked out with dotted lines indicating the page area. The Cyrillic canvas is essentially infinite but these marks will help you arrange your pedigrees prior to printing. Reset the page border  It is common for some individuals to be placed outside the page lines, for example, as a sibship grows. To set the pedigree within the page border either:   
• Select File|Page border menu item 
• Click the page border icon.  The Home button  To set the pedigree in the Home position - by default at the top left hand corner of the drawing use any of the following methods:   
• Select View |Home  
• Click the Home icon on the toolbar  
• press Ctrl+H Redraw   As you draw or rearrange a pedigree you may need to move individuals or groups of individuals to make room for new individuals. To move an individual:  
• Select the individual by clicking on the symbol  
• Drag the individual to the new location   
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 To move a group of individuals:  
• Select the group either by clicking on an empty part of the drawing area and dragging around the group or clicking on them one by one whilst holding down the Shift or the control key 
• Drag the group to the new location  For automatic redraw of the pedigree either  
• Select View|Redraw  
• Press F5  
• Click the Redraw tool  This redraws focusing on placing individuals in the correct generation, i.e., it realigns the pedigree in a vertical fashion. The redraw is focused on a selected individual but will work even if none are selected. This should be used with caution and prior to redrawing it is wise to take a snapshot (See using snapshots) of the pedigree just in case the results are not what you expect! Using the Snapshot Feature  The snapshot is really a customized ‘Undo’ feature. At any time you may take a snapshot of the pedigree and save it temporarily to memory. The snapshot includes the pedigree and all the data (results of risk calculations, annotations, properties). If you then make changes which turn out to be unsatisfactory you can return to the earlier state defined by the snapshot You can take as many snapshots as you like but should remember that they are lost when you close the database. Snapshots are useful:  
• When performing risk calculations as they allow you to edit data and/or the pedigree, do a calculation and save results for comparison     
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• When using the redraw feature the results may be unpredictable and so take a snapshot before doing the redraw  To take a snapshot:  
• Select Edit|New snapshot  
• Type a name for the snapshot in the Create new snapshot dialog  
• Click OK  Make any changes to the pedigree. If you decide to return to the previous state:  
• Select Edit|Go to snapshot  
• Choose the snapshot you wish to return to from the sub-menu  
• If you are prompted to create a new ‘autosnapshot’ to preserve the current status so choose Yes or No  All snapshots are lost when you close the pedigree or the database. Within the database you can create snapshots for different pedigrees and these are entirely independent. You will only be prompted to create an autosnapshot if you have created a state which is different from any of the snapshots already stored. Some advanced drawing features  Cyrillic has many features that enable you to work quickly and efficiently even when creating complex pedigrees. Remember that the drawing is linked at all times to the database so that as you add individuals and families you are creating database entries. In this final section we cover some useful tips on drawing pedigrees.   



Drawing pedigrees 

Cyrillic 3.0.400  60

 When a new individual is added that individual is highlighted so that a new relationship can be created directly. When a new partner/marriage is created then Cyrillic highlights the (horizontal) marriage line in readiness for the addition of offspring. As such you can create a sibship either by repeatedly adding offspring to a marriage or by adding siblings to a selected individual. Untangle the lines  You may have already noticed that Cyrillic is completely open in the pedigrees it allows you to draw. You can create 'social' pedigrees in addition to what might strictly acceptable as genetic pedigrees. For example you can draw a single parent with several children, relationships between males or females and add multiple sets of parents. This may lead to a tangle of lines that makes distinguishing relationships difficult. Cyrillic offers help both to the on-line user and in arranging relationship lines for the printed page. To demonstrate the following features draw the pedigree - two brothers marrying two sisters (shown below).  
• New male  
• New partner (female)  
• New male   

 Two family pedigree with the brothers marrying the sisters  
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• New partner (female)  
• Select the first marriage line  
• New son twice  
• Select the second marriage line  
• Click New daughter twice  
• Select the first daughter and drag to be adjacent to the first son  
• Select the second son and click to be close to the second daughter so that the horizontal lines overlap as in the above figure  
• Select the elder son and elder daughter then click New relationship to create the marriage   
• Repeat for the younger son and daughter Highlights   Click on one of the marriage lines and see that not only is this relationship line highlighted but so are the lines joining all the offspring from that relationship. Click on an empty part of the pedigree to deselect the marriage line and click on one of the lines between siblings. This also highlights all the sibling lines and the relationship from which they are derived. Double clicking any of these lines opens the Marriage dialog.  Another illustrative use of highlights is to show descendents. Add some children to one of the second-generation marriages.     
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 Three generation pedigree  

• Select one of the second-generation parents  
• Select View|Highlight descendants   
• Click on the blank drawing area to deselect the individual  You should now see that the individual, spouse and all the descendents from that point are highlighted.  
• Reselect the parent  
• Choose Show descendants only from the View menu  All the individuals above the selection and in other parts of the pedigree are removed from the display. To view only the parts of the pedigree above the selection:  
• Select View| Hide descendants 
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 To remove individual, spouse and all the descendents. To show the whole pedigree again:  
• Select View|Show all individuals   Finally to remove the highlights:  
• Select View|Clear highlighting  Note that the Show descendents only and Hide individuals are functions related to the selection - not the highlight which is purely an illustrative feature. This is also the case when you hide parts of the pedigree - they are just removed from the view but are still in the database. Move one set of siblings  The Highlights feature is helpful for the Cyrillic user – clearly indicating the offspring of a marriage even if there are several overlapping sibships - but what about the printed pedigree? Lines between siblings are always horizontal and so moving one set of siblings down separates the two sets clearly. Using the same    drawing remove the grandchildren so that you have the simple two generation pedigree.  
• Select both daughters  
• Drag the symbols down a small distance  The pedigree should now look like the figure below              
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 The pedigree with one set of siblings offset vertically  Marriage dialog: layout tab  An alternative to moving the siblings in one generation is to change the marriage drawing options. This also has the advantage that the changes are not affected by using Redraw.  If you realign certain parts of the pedigree in the vertical direction then Redraw will set them back inline with their generation – undoing your work!.               
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 The layout tab of the marriage properties dialog  Reset the pedigree so that all children are on the same horizontal. Open the Marriage dialog :  

• Double click the Marriage line between the first set of parents 
• Click the Layout tab 
• Ensure that the 'Use default sibship line position' option is unchecked 
• Set the 'Sibship line fine adjustment' to 48% or 49% either using the vertical scroll bar on the preview or editing the text directly 
• Click OK  This dialog can be used to set precisely the layout of a sibship in relation to the parents. The result should be something like the figure below.   
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 The pedigree after altering marriage display properties Using loops  The display can be further clarified by using loops to suggest crossover of horizontal and vertical lines. Although useful this does slow down redraw times and this increases significantly with large pedigrees. To display cross-over loops:  

• Select View |Options or press F6 to open the View options dialog 
• In the Drawing options tab check the Loops on check box 
• Ensure that the loops size is set to 8 or 10 
• Click OK           



Drawing pedigrees 

Cyrillic 3.0.400  67
  The pedigree showing the use of loops to define relationships   
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 Individual properties  When an individual is added to a pedigree it already has a great deal of associated information; identification details (an accession, drawing, and generation numbers), the genetic status, test status and mortality. Many of these properties are easily edited and you can add more information such as addresses, comments and ethnicity. In a subsequent chapter we will also show how you can add customize the database to store any information you wish.  There are several ways to edit the default data so that you can work in the way you find most convenient. You can use menus, toolbars, dialog boxes and Table View.  Using the Individual dialog  The individual dialog allows you to set or edit all of the properties associated with an individual. This has three panels, Individual properties, User-defined fields and manifestations. Here we will concentrate on the Individual properties tab. The User-defined fields tab is concerned with customized databases (Chapter 15) and the Manifestations tab is concerned with preparing the pedigree for genetic disease risk analysis (Chapter 17). Open the individual dialog  To open the Individual dialog either:   
• Double click an individual  
• Select an individual and choose Edit properties from the Modify individuals main menu or RMB menu  
• Select an individual and press F12 
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 Identification details  The first column comprises a number of edit boxes allowing input of personal data. To add information click in the box and add the text. A drop down menu allows you to set the gender as male, female or unknown - although this is pre-set by drawing a male, female or unknown on the drawing area. Changing the setting here changes the drawing. If you wish to simplify a drawing or do not know precise family details you can add a symbol and label it as a given number of individuals by editing the number under Number of individuals.  
 The individual dialog 
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 Dates and ages   Under Information there are three boxes allowing you to set or calculate ages and dates - Age, Date of birth and Date of death. Knowing two of these naturally allows you to calculate the other. It is important to note that Age is not necessarily the current age of the individual and the precise definition depends on what you intend to do. The possible definitions are as follows  
• The current age  
• The age of death, if the person is dead  
• The age of onset of a manifestation   To add the age:  
• Double click in the Age edit box and type a whole number    To add the date of birth:  
• Click the calendar icon  
• Use the calendar to select a date  
• Type the four-digit year in the Year edit box  You can now calculate the date of death:  
• Click the calculator icon next to Age of death  This feature should be used with caution. Calculating the age from the date of birth calculates the current age, i.e., the age when you perform the calculation. If you are creating a pedigree retrospectively then just type the age in the Age edit box. Do not calculate the age of death unless you need this. Once calculated the  
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program will assume the individual is dead. As you cannot edit the Date of death directly you must reset the null value. To do this:  
• Open the Date of death calendar  
• Set the date to 1st January, Year 1 (type 1 in the Year edit box)  You can use these three items in any sequence to set and calculate the relevant dates or age. Other information  Under Information and genetic status you can set the following properties:  Property Selections/Notes Pregnancy Unknown, Not a pregnancy, Spontaneous abortion, Therapeutic abortion, Stillborn, Lived one day, Neonatal death. No issue Normal, No issue, No children by choice, Infertility. NB add comments under Details. Proband, Not a proband, several selections for the position of the proband.  Mortality Alive, Dead, Unknown, Suicide. Adoption Not adopted, Adopted in, Adopted out, Maybe adopted in. Genetic Status Clear, Unaffected, Affected, Carrier, Maybe affected, Hererozygous. Test Status Normal, Untested, examined, Side cross, Top cross, Cross, Hearsay. Additional Status None, Plus symbol, Minus symbol  
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Additional information  Three other edit boxes are available for you to add arbitrary text. These are labelled Comments, additional information, Country of origin and Ethnicity. Hide information  Finally, checking the Hide information check box hides any information displayed for this individual only. The information displayed is controlled by the Displayed fields dialog, opened from the View options menu (View|Options menu, Chapter 7 of the Cyrillic 3 Manual. Customizing the view)  As an exercise set the following properties for the first generation female in this pedigree drawn in the previous chapter:  Last name:  Jones First name  Janet Gender:   Female Mortality:   Alive Pregnancy status:  Not a pregnancy Genetic status:  Known to be a carrier Age:   55 Adoption status:  Not adopted Test status:  Examined  
• Double click the first generation female  One of the useful things in Cyrillic is that several of the properties are already set, we have created a female, she is alive, not a  pregnancy and not adopted. Look at these items in the Individual dialog. Now set the other properties.  
• Click the arrow on the Genetic status drop down list and select carrier  
• Double click in the Age edit box and type the number 55  
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• Click the arrow on the test status drop down list and select Examined  
• Click OK to accept the changes and close the dialog   Edit properties using toolbars  The Modify Individuals toolbar is used to change the properties of an individual or group of individuals. To do this:  
• Select the individual or group of individuals  
• Click the toolbar button for the property you wish to change  In Cyrillic a pregnancy refers to the individual as the foetus or neonate, and possible outcome of the pregnancy - not to the status of being pregnant.   All of the buttons have tool tips - short hints which appear when the cursor is placed over the button, making it easy to identify the function of each tool. Toolbar buttons are toggle switches - alternately switching the property on and then off with consecutive clicks. If a property can have several values then repeatedly clicking the tool cycles through the various options.  Label several In this section we will further modify the properties of the pedigree individuals produced in the Chapter 5.     Select the two-second generation males by clicking on an empty part of he pedigree and dragging the mouse around them  
• Click the Maybe affected toolbar button  The '?' symbol is added to both male symbols. To see how the toggle works:  
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• Click on the Maybe affected symbol again    The symbol is removed. Label a Proband   We will now label the youngest female in this pedigree as a proband.  
• Select the youngest twin  
• Click the Proband tool to set the individual as a Proband  
• Click the Proband tool repeatedly to set to proband arrow in different locations.  A keyboard shortcut Ctrl+R may be used to toggle the proband arrow though this places the arrow in the bottom left corner of the symbol and removes all other probands from the pedigree.   Toolbar Buttons   Below is a complete list of the Modify individuals toolbar buttons and their functions.    
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Edit properties using menus  After selecting an individual you can change the properties using either the main menu or the context menu. Changes are made using the Modify Individuals menu and sub-menus.  
 Modify Individuals menu and sub-menus  For example to set the affection status of an individual:  

• Select the individual  
• Select the Modify individuals|Affection|Carrier menu item from either the main menu or the RMB context menu  The individual is labelled with the carrier symbol. As with toolbars the labels are either simple toggles or will cycle through the options if several are available. To remove the Carrier label:  
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• Select the individual labelled as a carrier  
• Select the Modify individuals|Affection|Carrier menu item  The label is now removed.   The menus also function for setting properties for several individuals. To label several individuals with a cross:  
• Select several individuals, either by dragging the mouse around the symbols or using the Shift+click technique  
• Click the Modify Individuals | Miscellaneous | Cross menu item  Edit properties using the Table View  The Cyrillic Table View displays pedigree details in a grid format. The table is completely configurable both in layout and in the pedigree properties it displays. The default view of the Table is empty and is controlled using the Table panel of the View options dialog. The layout may take either of two formats - horizontal or vertical.     The vertical (upper) and horizontal (lower) Table Views  
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 The vertical view has fields listed in the first column, the horizontal in the first row.  
• Select the View|Options menu item 
• Click the Table options tab 
• Click the radio button labelled Vertical in the General panel Configure the Table View  To choose which fields or properties to display in the table:   
• Open the View options dialog (View|Options or F6) 
• Click table fields  The Display fields dialog lists all the properties you can display. A more complete description is given in Chapter 7 but for this exercise we will display Surname, Age and mortality.  
• In the left hand column locate and select Surname 
• Click > to add this field to the list on the right 
• Select Age and click > 
• Select Mortality and click > 
• Click OK and OK in the main View options dialog   These fields should now be displayed in the table view  The table view is dynamically updated when the individual properties are set using menus, toolbars or the Individual dialog. Similarly when you use the Table view the Individual dialog will reflect the changes and additions. Navigating the Table View The table view looks like a spreadsheet and is navigated in a similar fashion:  
• Click on a cell to select it 
• Move around using the Up/Down/Left/Right arrows    



Individual Properties 

Cyrillic 3.0.400  80

 When an individual is selected on the drawing the row (horizontal view) or column (vertical view) for that individual is also highlighted making it easy to locate in the table view. Editing Properties in the Table View  As can be seen in the Individual Properties dialog box there are several kinds of properties, free text, numerical values, and those with only a limited number of values. How you edit these in the Table view depends on the type of property.  
• To edit free text or numerical values select a cell and type the text 
• To edit properties with a limited number of values (two or more) press Enter repeatedly to cycle through the possible values  For example, edit the properties if the first generation male in the pedigree created in Part 6.  
• Click the cell labelled Surname in the first column (with the table in Horizontal view) 
• Type Jones and press Enter 
• Press the Right arrow key twice so that the eldest second generation male is selected 
• Type Jones and press Enter  Now change the mortality status of the second son:  
• Press the right arrow key and then the down arrow key repeatedly so that the Mortality cell for the second son is selected 
• Press the Enter key twice to change the Mortality to Dead 
• Press the Enter key twice again to change the Mortality to Unknown     
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  To change a numerical value such as Age select the cell either by locating it using the arrow keys and pressing Enter and then type in numbers.  Some care should be exercised when editing properties with a fixed number of values e.g., the proband or the gender. It will be possible to enter text in the gender field but as you press Enter to accept the text the table merely cycles to the next allowed value - which may result in some confusion between what you have typed and what you see as the result.  In practice the table can be used for rapid data input and is particularly useful when you have large pedigrees. Another hint for speed is to use the Set Individual defaults dialog and Set marriage defaults dialog, accessed from the Setup menu. these are identical to the Individual and marriage dialogs but the properties set become default for a whole database. So if you are developing a database for an extended family, all called Jones you can set the default surname and do not need to add this information later for every individual.  
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 Printing alternatives  Cyrillic 3 pedigree images can be exported in the Enhanced Metafile format (*.emf). These files can be imported into Word and other office tools and are editable (as images only) once imported.  In print preview select the icon that represents a floppy disk (save as meta file), save the file to a location where you can find it later.  Now open Microsoft word (PowerPoint or Excel) go to Insert/Picture/from File find you file and open it.    You can also copy and paste the image directly into word, Edit/Select all then Edit/Copy in Cyrillic then Edit/Paste in Word) although this will not include the legend unlike the save as metafile method.  Printing across multiple pages  In the main view the page borders are defined by dotted lines. Drag the whole pedigree, Edit/Select All then hold down left mouse button and drag to the right or to the bottom of the screen until it crosses the page border and then you open the print preview and click on the View All button then multiple pages with the pedigree spread across them can be seen.  Alternatively you can export the image to MS office software see Printing alternatives above  License Transfer – alternative instructions  Cyrillic 3 will allow you to transfer the license using a floppy disk from one PC to another.   1) Firstly install Cyrillic on your home PC.     
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 2) Place a blank floppy disk in the home PC. Now on the home PC and select Help/License transfer. This opens a window in which you need to select the Request License option and then click OK.   Now you have a floppy disk that can 'pull' the license from your fully licensed copy of Cyrillic at work.   3) Go to the work PC. Place the disk from step 2 in the PC and open Cyrillic 3.   4) Select Help License transfer. Click on OK to transfer the license from the PC to the floppy. The Work PC copy of Cyrillic is now temporarily inactive.  Back to the Home PC  5) Place the floppy disk in the PC. Select Help/License transfer and then Select Check in license.   The transfer process is now complete. Transferring the license back is a very similar process and is easier because the license request step 2 is not required. The license is simply checked out from once PC and then in to the other each time you transfer.  BDE Errors  “Cannot load an IDAPI service library  File C:\Windows\MSAPPS\DAO\DAO 3032DLL Alias: Cyrillic 3 Internal”  To check the settings go to your control panel (Startup menu / Settings), open the BDE administrator.  Go into Configuration, Drivers, Native, Access. The DLL 32 setting should be IDDA3532.DLL if it is not change it by using the drop down menu which pops up when you click on the cell. Now close down the window and open up Cyrillic.  
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 If the above fails, try re-installing Cyrillic on your PC, please save back up copies of all your databases in a separate file location from the Cyrillic directory  Access Violation "Access violation at address 00480620 in module Cyrillic.exe"  This is an issue with the BDE (Borland Database Engine) a third party software that is installed with Cyrillic for the database side of the program. There have been issues relating to the BDE and its interaction with the components Microsoft use mainly the MDAC (Microsoft Database Access Component). The latest patch for the BDE is available on the Borland web site http://info.borland.com/devsupport/bde/bdeupdate.html  The file you need is at the end of the page and is called bde511en.exe   BDE v5.1.1 Download Availability Language FTP Self-Extracting  English bde511en.exe   Database Errors List Index Out of Bounds "list index out of bounds (0)".   The error occurs due to a corruption of database data in the PEDCORE table in the Options cell (first row).  The table and cell can be located in MS Access 97 and the row that contains the corrupt data can have the data removed. The corrupt cell will contain random character on one line only. Please make sure you keep a back up copy of the database before you make any changes in MS Access. Once this change has been made save and close the file. Now open the database in Cyrillic 3 and check that new pedigrees can be created once again.   
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 We are at present not sure what caused the corruption and are still investigating. I will keep you up to date on any further developments.  If you do not have a copy of MS Access 97 or are unable to fix the database you are welcome to send the database to our support team, all data will be treated with the utmost confidence and databases will be permanently deleted from our systems once we have returned a copy to you.  Please note that if you have MS Access 2000 you have to convert to database to 2000 format, change the cell and then convert it back to MS Access 97 format.  .
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 This completes the getting started guide. There are many other options available for drawing and annotating pedigrees or for preparing output to in GEDCOM or CSV files. However, you have covered most areas in outline and should be able to confidently create your own pedigrees   The reference section in the Cyrillic 3.0 Manual  (on the CDROM) covers all aspects of the program in detail. Explore it at your leisure as you become more familiar with Cyrillic, and refer to it when you aren’t sure of a feature. If you still cant do what you want you can also get technical support by contacting us using the details at the start of this manual.   


